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Read This First!

YYoouu  NNeeeedd  aa  PPeerrssoonnaall  CCoommppuutteerr  WWiitthh  aa  UUSSBB  PPoorrtt    

MX-3000 Editor will run on any Pentium II or faster Windows PC. Your PC should be equipped with an adequate
amount of RAM for the operating system you use. MXEditor is compatible with the Windows 98, ME, 2000, XP and
XP Pro operating systems. It is not compatible with Windows 95 or previous versions of windows.

MX-3000 Editor is installed via a self extracting installer file downloadable from www.hometheatermaster.com. You
need a connection to the internet to download the file or to update MXEditor.

IInnssttaalllliinngg  MMXX--33000000  EEddiittoorr  aanndd  MMiiccrroossoofftt  AAccttiivveeSSyynncc    

MX-3000 Editor installs with a companion program for communication, Microsoft ActiveSync.You must install both
programs and if uninstalling, uninstall both programs.To install the two programs, follow these steps:

11 Connect to the internet and go to this website address:
http://www.hometheatermaster.com/mxeditor/downloads/mx-3000setup.exe

22 A file download Window will open. Click on OPEN.

33 The InstallShield Wizard Window for the MX-3000 Editor will open. Click on NEXT

44 The Install Destination Window will then open. Click on NEXT.

55 The Ready to Install Window will open. Click on INSTALL.

66 The program will install and then show that installation has been completed. Click on FINISH.

77 A new small window will open asking, "Install the Microsoft Active Sync 3.7". Click OK.

11GGeettttiinngg  SSttaarrtteedd
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88 A new set up window will open for ActiveSync 3.7. Click on NEXT.

99 A new window will open to select the installation folder. Simply click on NEXT.

1100 A new window titled "Get Connected" will open. Do not do click on any button in the Get Connected
window yet.

1111 After the Active Sync Installed window opens, Click OK.

1122 At this point plug the USB cable into your computer and then the MX-3000 Remote.

22 GGeettttiinngg  SSttaarrtteedd

U
S
I
N
G

M
X
3
0
0
0

E
D
I
T
O
R

T
O

P
R
O
G
R
A
M

The Get Connected window will
automatically update. Do not
click on NEXT.



1133 The Get Connected Window will close and then a "Set Up a Partnership" Window will open.At this point
you can make two choices. Please read and make sure that you understand both choices before proceed-
ing:

YYeess - This will set up a partnership with that particular MX-3000.This is ideal for an end user, as they typi-
cally will not be programming multiple MX-3000's. Every time the same MX-3000 is plugged in, it will auto-
matically establish the connection.

After choosing Yes, a new "Select Number of Partnerships" Window will open. Chose "Yes, I want to syn-
chronize with only this computer" and then click NEXT.

A "Select Synchronization Settings" Window will open. Un-check all of the boxes as these features do not
pertain to the MX-3000 and then click NEXT.

The Set Up Complete Window will then open. Click FINISH.A new window will open showing that a con-
nection to the MX-3000 has been established.

NNoo - This is best for installers, as they will be programming multiple MX-3000's.This is considered a
"Guest" partnership. Each time that the MX-3000 is plugged in, it will open the get connected window and
the programmer will need to click "No" to establish a connection with the MX-3000.

After clicking No, the Microsoft ActiveSync Window will open and show that a "Guest" connection has
been established.

KKeeeepp  YYoouurr  DDaattaabbaassee  UUpp  ttoo  DDaattee  ——  UUSSEE LLIIVVEE UUPPDDAATTEE    

MX-3000 Editor includes a vast library of IR codes for hundreds of brands and models of A/V components.This data-
base is constantly growing with the inclusion of new devices every month. Keep your software up to date by using
the Live Update feature. Rather than un-installing and re-installing the software, you download updates to the soft-
ware from the internet. Simply follow these steps:

11 CCoonnnneecctt  ttoo  tthhee  IInntteerrnneett  nnoorrmmaallllyy..

22 OOppeenn  MMXX--33000000  EEddiittoorr

33 FFrroomm  tthhee  CCoommmmuunniiccaattiioonnss  MMeennuu,,  sseelleecctt  LLiivvee  UUppddaattee

44 IInn  tthhee  LLiivvee  UUppddaattee  wwiinnddooww,,  cclliicckk  oonn  UUppddaattee  NNooww..

55 WWaaiitt  ffoorr  tthhee  wwiinnddooww  ttoo  iinnddiiccaattee  tthhee  ddoowwnnllooaadd  iiss  
ccoommpplleetteedd..  CClloossee  tthhee  WWiinnddooww..

66 CClloossee  aanndd  rree--ooppeenn  MMXX--33000000  EEddiittoorr..  YYoouu  ddoo  nnoott  nneeeedd  ttoo
rreessttaarrtt  WWiinnddoowwss..

33GGeettttiinngg  SSttaarrtteedd
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The Programming Window

Menus and Shortcut buttons for common tasks. The Program Menu activates each task in the correct order.

Tree View of the MX-3000 configuration. Double clicking on any page enables you to quickly display that
page on the simulator view. Right clicking on a device or page activates a context menu.

The MX-3000 Simulate View is used to navigate and to select a button to program, edit or record a macro.

Edit and Label Buttons window is used to control a buttons graphics, text and activation.

The Macro window is used to view and edit macros.

The information bar displays whether your keyboard is cap locked or num locked.

The important thing to remember as you program is that most Windows conventions hold true in MX3000 Editor.
Explore the program menus. Hover your mouse over most of the buttons and controls and a balloon will appear
with a hint as to purpose. Navigate around the program window and explore a little before you begin programming.

44 WWiinnddoowwss,,  MMeennuuss,,  TToooollss  aanndd  DDeeffiinniittiioonnss
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The Menu Bar and the Menus

Like all Windows programs, the menu bar reveals menus of commonly used tasks. Simply click on the menu title and
the menu appears. Move the mouse cursor over the menu choice you wish to select and click.

FFiillee  MMeennuu  

Configurations for particular clients are saved as .rcc files on your PC.Thus the file menu enables you to open, save
and import all or part of a configuration.

NNeeww - Use this to start programming a file from scratch.
OOppeenn - Use this to open a file anywhere on your computer.

SSaavvee - If you wish to save your work to the current file.
SSaavvee  AAss - If you wish to save a new copy of the current file 
with a new file name.

IImmppoorrtt - Import Devices from other MX-3000 configurations.
EExxppoorrtt - Export Devices from the current configuration.
IImmppoorrtt  LLeeaarrnn  IIRR - Import only the learned IR commands from
another MX-3000 configuration.The learned commands import 
to the embedded Learned IR list, where they can be dragged to any button.

UUsseerr  PPrreeffeerreennccee - Opens the Preferences window, where you
can set defaults for this configuration.

RReecceennttllyy  FFiilleess  appear here for you to reopen with a click.

EExxiitt - To exit MX-3000 Editor completely.

EEddiitt  MMeennuu    

Once you have “selected” an item in Tree, Page or Simulator View, you can copy and paste, group and ungroup or
move the selected item.The item can be a device, page or button.

UUnnddoo  - Use this to remove the effect of the last action you made.
RReeddoo - If you have used undo, you can cancel with redo.

CCuutt  - Use this to copy and delete the item selected.
CCooppyy  - Use this to copy without deleting.
PPaassttee  - Use this to paste a new copy of the last item copied.
PPaassttee  AAccttiioonn  - Use this to paste only the action list of a button.
PPaassttee  SSppeecciiaall  ll- Use this to paste only the image, the text, the position,
the action or the IR ID of the last item copied into another button.
PPaassttee  ffrroomm  CClliippbbooaarrdd  - Use this to paste an image you copied from 
another windows program into a button’s Before or After position.
DDeelleettee  - Deletes the selected item completely.
DDeelleettee  CCoonntteennttss  - Deletes only the contents of the selected item.

55WWiinnddoowwss,,  MMeennuuss,,  TToooollss  aanndd  DDeeffiinniittiioonnss
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SSeelleecctt  AAllll - Selects all the buttons on the currently displayed page.
SSeelleecctt  NNoonnee - Cancels the current selection without selecting anything new.

GGrroouupp - Groups a number of selected buttons into one group arrangement that
can be moved, copied and pasted as one.You select multiple buttons by holding down
shift key, then clicking on as many buttons as you like.
UUnnGGrroouupp - Cancels the grouping of buttons so that each button can be moved
independently.

MMoovvee  UUpp  LLiisstt - Moves a selected Page or Device up the list in tree view.
MMoovvee  DDoowwnn  LLiisstt - Moves a selected Page or Device down the list in tree view.

VViieeww  MMeennuu    

The workspace inside the MX-3000 Editor window can be arranged as you like.

MMaaccrroo  - Opens and closes the Macro window.
EEddiitt  &&  LLaabbeell  BBuuttttoonnss - Opens and closes the Edit & Label Buttons window.

SSiimmuullaattee  MMooddee - Most useful mode for programming button actions since you
can see hard buttons and the flag on each button denoting its programming type.
Only one page at a time can be viewed.
PPaaggee  VViieeww  MMooddee - Useful for extensive editing of images. Programming flags are
not visible, multiple pages can be viewed at once and page Zoom controls enable 
zooming in on a page.
BBootthh  SSiimmuullaatteedd  aanndd  PPaaggee  VViieeww - Allows both views to be active.

TToooollbbaarr - Opens and closes the toolbar of shortcut buttons.
SSttaattuuss  BBaarr- Opens and closes the status bar at the bottom of the window.

PPrrooggrraamm  MMeennuu    

Many of the Program Menu steps will open a new window in front of the main window. You can exit any of these
windows without making any changes by clicking on the Close button.

11..  CCrreeaattee  &&  NNaammee  DDeevviicceess  - Opens a new window for creating and naming devices.
You’ll need to name a device (a grouping of hard buttons and pages) for every remote
control that you are replacing.
22..  CCrreeaattee  BBuuttttoonn  LLaayyoouuttss - Opens a new floating window to select the button arrange-
ments for each of your devices from the pre-built templates.
33..  IIRR DDaattaabbaassee - Opens a new window to test and program IR code sets from the
Universal IR database.You can drag an individual code or the entire set of codes.
44..  LLeeaarrnn - Opens a new window for organizing, labeling and learning IR codes.
55..  PPuunncchh  TThhrroouugghh - Opens a floating window that enables you to program a button to
“punch through” to another device.Typically used to program Volume Up, Down and Mute to always operate the a/v
surround sound receiver.
66..  MMaaccrroo  PPrrooggrraammmmiinngg  - Opens the Macro window if it was closed. Starts the MACRO recorder if a button was
selected.
77..  RRFF  CCoonnttrrooll - Opens a new window for configuring the MX-800’s radio control options.

66 WWiinnddoowwss,,  MMeennuuss,,  TToooollss  aanndd  DDeeffiinniittiioonnss
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PPaaggee  MMeennuu    

AAdddd  NNeeww  PPaaggee  --  Add a new page to the selected device (tree view).
AAdddd  NNeeww  BBuuttttoonn - Add a new button to the displayed page (simulate or page view).
IIss  HHiiddddeenn - Make the currently selected button or page hidden from view when in use.
If the page or button is already hidden, a checkmark will appear.To make a page or but-
ton visible again, simply select the item, then select Is Hidden, the checkmark will disap-
pear and the item is visible again.
ZZoooomm - Only useable in Page View mode.The Zoom menu enables you to enlarge the
view of any page by 2x, 3x or 4x.
GGrriidd - Enables you to view, adjust or select a grid as an aid to alignment of your buttons.

MMoovvee  ttoo  FFrroonntt - Moves the currently selected button in front of all other buttons.
MMoovvee  ttoo  BBaacckk - Moves the currently selected button in back of all others.

TToooollss  MMeennuu    

IImmaaggee  GGaalllleerryy  --  Opens a window of button art.You can drag buttons from the gallery
to any page.
SSoouunndd  GGaalllleerryy  --  Opens a window of sounds.You can drag sounds onto any button.The
sound will appear as a macro step in the selected button.
PPeerrssoonnaall  CCCCFF  GGaalllleerryy - Opens a window that will allow you to open any ccf file.You
can drag any LEARNED IR command from the Gallery to any button.

MMaakkee  MMyy  IIRR  DDBB  --  Opens a window that enables you to customize the IR Database so
that you only see the brands and models you use on your installations.

RReeccoorrdd  TTiimmeerr--  Opens a window that enables you to specify that any button’s macro can
be automatically issued at a particular time of day (every day, weekly, monthly or only once).

RRuunn  EEmmuullaattoorr - Opens a new window emulating the MX-3000 for testing of navigation.
Close the Emulator by right clicking and choosing exit.

CCoommmmuunniiccaattiioonnss  MMeennuu    

UUppllooaadd  --  Get the programming from a remote control and open it in MXEditor as a
new file. Once it is uploaded, you can save it, edit it and/or export the devices in it.
DDoowwnnllooaadd  --  Send the currently open file to the remote control.
RReemmoottee  CCoonnttrrooll  SSeettuupp  - Opens a new window for you to adjust Backlight time-out,
brightness, volume, low battery warning and pick up sensor.
TTiimmee  SSyynncc  ffrroomm  PPCC - Sets the MX-3000 internal timer to the clock setting of your PC.

LLiivvee  UUppddaattee  -- If your PC is connected to the internet, clicking Live Update will open a
new window enabling you to update the MX-3000 Editor software with any new database
entries and or programming improvements.

RReemmoottee  CCoonnttrrooll  VVeerrssiioonn - If you are connected to an MX-3000, a new window will open, displaying the OS and the
Program version number.This may be useful to technical support.
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WWiinnddooww  MMeennuu    

The window menu is used when in Page View mode to control the many windows you can open at once:

CCaassccaaddee    --  This will cascade all open windows from left to right.
AArrrraannggee  IIccoonnss  --  This will minimize all open windows and arrange the minimized icons 
at the bottom of the window from left to right.

CClloossee - This closes the selected window.
CClloossee  AAllll - This closes all Page View windows, but leaves MX-3000 Editor open.

HHeellpp  MMeennuu    

TTuuttoorriiaall  --  This will open a new window with an interactive tutorial, complete with 
movies that demonstrate how to program an MX-3000.
GGoo  ttoo  WWeebbssiittee  --  Click on this after connecting to the Internet to go to the Universal
Remote Control website for more on line learning resources.

AAbboouutt  MMXX--33000000  EEddiittoorr  - This opens a new window displaying the versions of MX-3000 Editor installed on your PC.

The Toolbar and Shortcut Buttons
Hover your mouse over the Shortcut buttons, you will see a pop-up flag displaying the function of the shortcut. Click
on the button to activate it. The most common functions of the menus are displayed on the toolbar.

The Simulate View Mode

OOppeenniinngg  SSiimmuullaattee  VViieeww    

The Simulate view mode is the center of programming activity. To open this view, go to the View Menu and select
Simulate Mode as shown or press the shortcut key F5.
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When you hover the mouse over a shortcut button,
a pop-up flag will display it’s purpose.



SSeelleeccttiinngg  BBuuttttoonnss  iinn  SSiimmuullaattee  VViieeww    

You use the Simulate view to SELECT a BUTTON by clicking on it with the mouse. When a button is SELECTED it
has a red rectangle around it. Once a button is SELECTED, you can move it, copy or cut it, delete it or use the Edit
and Label Buttons Window or the Macro Window to program it.

When you want to switch to a new device, first, click on the MAIN button.

Choose the new device from the MAIN MENU by ddoouubbllee cclliicckkiinngg on it.
On a real MX-3000, the double click is not necessary. But within MX-3000 Editor 
you sometimes will want to select it for editing or macro programming.

Cycle through the pages of any device by clicking on either of the PAGE button.

Hover your mouse over a button to see the drag and drop flag.

Click on a button to SELECT it.A red rectangle will appear around it.

BBuuttttoonn  FFllaaggss  iinn  SSiimmuullaattee  VViieeww  MMooddee  

A button with no flag will not do anything when pressed. It is empty and has no programming yet.

A P indicates that the button is programmed with an IR database code. An IR database code can be
tapped or pressed and held for a sustained burst. All buttons can be programmed with IR database codes
(you cannot program the navigation buttons - either PAGE or the MAIN button).

An L flag indicates that the button is programmed with a learned IR code. A learned code can be tapped
or pressed and held for a sustained burst. All buttons can be programmed with learned codes (including
all MAIN buttons, hard and soft) except the navigation buttons.
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The red rectangle indicates that the TV button is SELECTED.



An M flag indicates that the button is programmed with a Macro. All buttons can be programmed
with MACROS except the navigation buttons. A macro with a single step cannot be pressed and held
for a sustained burst.

A PT flag indicates that the button is programmed to “Punch Through” to another device.

The pop-up flag will appear after you have clicked on one of the buttons on the page.
Thereafter, whenever you move the mouse over a button with a learned or a pre-pro-
grammed IR command in it, a pop-up flag appears, displaying the actual code name.

Tree View 

DDeevviicceess  aanndd  PPaaggeess    

Tree View controls what you see in the Simulator or Page view. It serves as the quickest way to navigate (especially
when programming macros) and enables you to cut, copy and delete devices and/or pages via the right click context
menus.

AA  PPaaggee refers only to a group of soft buttons, not to the hard buttons in the same device.
AA  DDeevviiccee is comprised of up to 255 pages of soft buttons and one set of functions for the hard buttons.

Double Click on a device to expand or collapse your view of its pages (or you can single click on the +/-).

A Double click on a page in Tree View will change the SIMULATE view to the selected device and page.
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Collapsed Expanded

The quickest way to navi-

gate is to keep tree view

expanded, so that you can

double click on any page

to display it in Simulate

view mode.



Right click on MAIN to reveal the Device Context Menu:

AAdddd  NNeeww  PPaaggee  enables you to insert an additional page to the MAIN Menu (to a maxi-
mum of 255 pages).
PPaassttee  PPaaggee will paste the last copied page into the MAIN menu.

DDeelleettee  CCoonntteennttss will delete all labels and codes but not the pages.

TToooollss  >>  IImmaaggee  RReeppllaaccee  will open a new window allowing you to browse to a folder
with new images for all of your button graphics.Any image with the same name as the
images in your current configuration will be replaced.

Right click on a device to reveal the Device Context Menu:

RReennaammee  enables you to type in a new name for the device.
CCuutt will copy the entire device and when pasted will delete the original.
CCooppyy will copy the entire device without changing the original.
PPaassttee will paste the copied or cut device as a completely new device with the same
name.
DDeelleettee will delete everything about the selected device.
DDeelleettee  CCoonntteennttss will delete all codes and macros but not the labels, buttons or pages.
MMoovvee  DDeevviiccee  UUpp moves the device up the list of devices.
MMoovvee  DDeevviiccee  DDoowwnn moves the device down the list of devices.
AAdddd    NNeeww  PPaaggee will insert an additional page to the device (to a maximum of 255).
PPaassttee  PPaaggee  will paste the last copied page into the device.
TToooollss  >>  IImmaaggee  RReeppllaaccee  will open a new window allowing you to browse to a folder
with new images for this device’s button graphics.Any image with the same name as
the images in the current device will be replaced.

Right click on a page to reveal the Page Context Menu:

RReennaammee  enables you to type in a new name for the page.
CCuutt will copy the page and when pasted will delete the original.
CCooppyy will copy the page without changing the original.
PPaassttee will paste the page into the selected device.
DDeelleettee will delete the selected page completely.
DDeelleettee  CCoonntteennttss will delete all codes and macros but not the labels, buttons or page.
MMoovvee  PPaaggee  UUpp moves the page up the list of pages.
MMoovvee  PPaaggee  DDoowwnn moves the page down the list of pages.
IIss  HHiiddddeenn will make the page invisible on the remote control yet still available for
macro programming.
OOppeenn  PPaaggee will display the page in the Simulate View or the Page View mode (whatever
was last selected).
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Page View Mode

OOppeenniinngg  PPaaggee  VViieeww    

The Page view mode is only useful when doing extensive editing of your button layouts.
To open this view, go to the View Menu and select Page View Mode as shown or press
the shortcut key F6.

BBuuttttoonn  LLaayyoouutt  EEddiittiinngg  iinn  PPaaggee  VViieeww  MMooddee    

In page view mode, you can have as many pages as you like open at once.The larger your screen, the more pages you
can fit. In the illustration below, you can see many pages open at once as well as opening the Image Gallery.This
greatly speeds copying and pasting of buttons from one page to another and encourages direct comparison.

UUssiinngg  tthhee  WWiinnddooww  MMeennuu  iinn  PPaaggee  VViieeww  MMooddee    

When you are in page view mode, the Window menu commands are extremely useful:

CCaassccaaddee    --  This will cascade all open windows from left to right.
AArrrraannggee  IIccoonnss  --  This will minimize all open windows and arrange the minimized icons 
at the bottom of the window from left to right.

CClloossee - This closes the selected window.
CClloossee  AAllll - This closes all Page View windows, but leaves MX-3000 Editor open.
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The Edit and Label Buttons Window

OOppeenniinngg  TThhee  EEddiitt  &&  LLaabbeell  BBuuttttoonnss  WWiinnddooww  

If the Edit and Label Buttons Window is closed, reopen it by hitting F4 or selecting Edit
and Label Buttons from the View Menu.

EEddiittiinngg  BBuuttttoonn  LLaabbeellss    

BBuuttttoonn  TTeexxtt  CCoonnttrroollss    
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NNoorrmmaall  TTeexxtt

This is the label you see on the

button before you press it.

Simply click in the window and

type to change the button label.

DDyynnaammiicc  TTeexxtt

This is the label you see on the

button after you press it. MX-

3000 Editor automatically copies

whatever you typed in the

Normal Text window, but you

can overwrite it by clicking the

Dynamic Text tab.

NNoorrmmaall,,  DDaattee,,  TTiimmee  oorr  PPaaggee

You can have a button display the

Normal Text, the date, the time

of day or the page the button is

on via these radio buttons.

DDiissppllaayy  TTeexxtt

You must check off this box for

the label to be displayed.

Uncheck the box when you are

using button art that has text as

part of the image (like the icons

for VCR, DVD etc.).

BBoolldd,,  IIttaalliicc  oorr  UUnnddeerrlliinnee

You can select or combine the

Bold, Italic or Underline styles

with these buttons.

FFoonntt  

You can select any of the fonts

displayed in this pull down list

box.

FFoonntt  SSiizzee

You can select any of the sizes

displayed in this pull down list

box.

FFoonntt  PPrreevviieeww

You can see a preview of your

color, style and font settings

here.

NNoorrmmaall  TTeexxtt  WWiinnddooww  

Click in the window and type. If

you want more than one line, hit

return to make a new line.

CCoolloorr  ooff  TTeexxtt

You can select any color by click-

ing the Color button, which

opens the Color window.



BBuuttttoonn  IImmaaggee  CCoonnttrrooll  

You can import a BMP, GIF, JPG or animated GIF file from a image editing program (too many to list but one,
Microsoft Paint, is distributed free with Windows, under Accessories in your Start|Programs list).The restrictions are
that the art must be no greater than 24 bit color depth, 72dpi, and no larger than the screen (320 pixels by 240 pix-
els). Note that if you have already loaded an image into either the Before or the After positions the button will reject
art that is a different size. Both the Before and the After image must be exactly the same pixel dimensions. If you do
not load an image into a button, the button is resizeable anytime (it can only be a rectangle, but you can change the
background color to any color).

BBuuttttoonn  IImmaaggee  IImmppoorrtt  aanndd  EExxppoorrtt  
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AAnniimmaattiioonn  CCoonnttrroollss

If you import an animated GIF

file you can override the default

animation settings with this list

box. If you choose Animate

Once, the animation will loop

one time. If you choose Animate

Always, the animation will loop

forever. If you choose Animate

Default, the animation will loop

for the number of times you

specify in your image editing pro-

gram.

IInnvveerrtt  BBeeffoorree  IImmaaggee

As a shortcut you can opt to

simply invert all the colors of the

before image after the button is

pressed.

PPoossiittiioonn  aanndd  SSiizzee

You can type in new XY position

for a button and you can resize a

button without images by typing

in a new size. If you have import-

ed an image the width and height

boxes cannot be changed.

AAfftteerr  IImmaaggee

This is the image that will appear

after you press it (for as long as

you press it).After you stop

pressing the button, the button

will return to the Before Image.

BBeeffoorree  IImmaaggee

This is the image that will appear

on the button before you press

it.

IImmppoorrtt  IImmaaggee

Click on this button to browse

your computer for a graphic you

would like to import.

DDeelleettee  IImmaaggee

Click on this button to delete

the currently loaded image.

BBaacckkggrroouunndd  CCoolloorr

Click on this button to open the

color window and pick a color

for a rectangular button without

art.

EExxppoorrtt  IImmaaggee

Click on this button to browse

your computer and save the

existing image as a file anywhere

on your pc.



AAddvvaanncceedd  AApppplliiccaattiioonnss  --  VVaarriiaabblleess  aanndd  DDyynnaammiicc  OOppttiioonnss  EEnnaabbllee  ““DDiissppllaayy””  BBuuttttoonnss    

Variables offer many additional programming possibilities to the imaginative programmer.There are several ways to
utilize variables, one of them is by assigning a variable to a button. When you assign a variable to it and when the
push of another button sets the variable to 1, the dynamic button will react by displaying it’s After image for as long
as the specified variable stays set to 1.When you set a button to be dynamic, any other button can ALIAS to it (see
Macro recording on the next page) and trigger the dynamic button into displaying both its after image and its dynam-
ic text.The dynamic button will pulse or flash its After image and text as long as the macro written to the dynamic
button lasts (you can program delays as you like).This makes lots of interesting “display” buttons possible.
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DDyynnaammiicc  CCoonnttrrooll

Normally, keep the NNoonnee radio

button checked.When you make

a button Dynamic, it is possible

to make the button flash its

AFTER graphic and dynamic text

by aliasing to it from another

button.The dynamic button will

continue to flash the AFTER

graphic as long as the macro pro-

grammed in the dynamic button

lasts.

BBuuttttoonn  IIDD

This is not the button label.The

button ID is editable however.

The button ID is the label you

will see in the ALIAS window

when recording macros. If you

like, you can make a button easi-

er to find by editing the Button

ID to a more unique name.

IIRR  IIDD

This is not editable, except by

dragging and dropping a new IR

database code to this button.The

IR ID assigns codes from the

database to this button when you

choose to SAVE ALL of the

codes from a code set.

VVaarriiaabbllee

If you would like to make a but-

ton dynamically change to its

AFTER graphic when a variable

changes to 1, select the Variable

in the list box.

NNeeww  VVaarriiaabbllee

If you haven’t named a variable

yet, click on NEW to name it.

The NEW Variable window also

enables you to delete variables

that are no longer needed.



The Macro/Favorite Window

OOppeenniinngg  MMaaccrroo  WWiinnddooww  

If the Macro Window is closed, reopen it by hitting F3 or selecting Macro from the View
Menu.

TThhee  MMaaccrroo  SStteepp  BBuuttttoonnss    

TTEESSTT You must select the first step you want played back first, then connect the remote to the PC.
All steps after the selected step will play back, including any delays.

RREECCOORRDD Starts the macro recording process.This enables you to simply navigate to any page and sim-
ply click on a button to create an ALIAS to it.An “alias” is a copy of the button’s command.

SSTTOOPP  Stops the recording of macro steps

DDEELLAAYY Opens the Delay window so that you can specify a delay in between macro steps.

JJUUMMPP Enables you to jump to any PAGE of any DEVICE at the end of a MACRO.

SSOOUUNNDD Opens a Sound Window for you to select a sound as a macro step. Program a delay at the
same time as the Macro step to enable another sound to play after the first.

TTEEXXTT Opens a Text Window to type in text that will appear on the button as a macro step.
Program a delay at the same time as the text to determine how long the new text will stay
on the button.You can have as many text steps as you like (to the maximum of 255).

SSEETT  VVAARRIIAABBLLEE Opens the Set Variable window, which enables you to pick an already-created variable and set it
to 0, 1 or to simply Invert its status as a macro step. If you want to create a variable, you must
click on NEW at the top of the Edit & Label Buttons window to open the new variable window.

IIRR  DDAATTAA  Opens the IR Data window, which allows you to insert an IR command as a macro step without
aliasing to it.This is slower than programming an alias, but has the advantage that you can control
the IR commands burst length inside the macro, enabling sustained bursts of power on for pro-
jectors, or long busts of volume down at the end of a turn on macro. See Using the IR Data
Window on page XX.

IIMMPPOORRTT  You must select the button you want the macro imported to, click on the Import button,
then click on the button containing the macro you want copied. All of the macro steps are
inserted into the new button in one step. Make any changes you want to the new macro, it is
independent of the original (the original is not affected by any changes you make, nor is the
copy affected by changes you make in the original).

SSLLEEEEPP  TTIIMMEERR  Insert this as the first step of a power off macro. Label the button SLEEP TIMER. Each time the
user presses the button, the MX-3000 displays “Go to Sleep in 90 Minutes”, the next press it dis-
plays “Go to Sleep in 60 Minutes”, next it displays “Go to Sleep in 30 Minutes”, then “Go to
Sleep in 15 Minutes” and finally “Cancel”.Whenever the Sleep Timer runs out, the macro you
programmed will be issued (unless the user hits the cancel display).
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MMaaccrroo  MMooddee  BBuuttttoonnss  

Every button has the potential to do two different macros based on either a variable changing, or how long the user
presses the button. Play with these three Macro Mode buttons to get used to them.When you change from one
mode to another, the Option bar changes its display.When the Option bar displays, you have the ability to program
two different macros on one button as follows:

NNOORRMMAALL MMOODDEE In normal mode, the macro will be issued every time the button is pressed.

PPRREESSSS  MMOODDEE  In Press Time mode, the button can have two different macros.A unique macro will be issued
if the button is pressed less than the specified time (Before Option).A different macro will be
issued if the button is held down more than the specified time (After Option).When pro-
gramming the two macros, you switch between the two by using the Option bar at the far
right of the Macro window.

VVAARRIIAABBLLEE MMOODDEE In Variable mode, the button can have two different macros.A unique macro will be issued if
the button is pressed when the specified variable is “0” (0 Option).A different macro will be
issued if the button is pressed when the specified variable is “1” (1 Option).When program-
ming the two macros, you switch between the two by using the Option bar at the far right of
the Macro window.
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When you click on Before, the macro win-
dow displays the Before Macro.

When you set the time in the list box, you
specify how long the user has to press the
button to get the After macro.

When you click on After, the macro window
displays the After Macro.

When you click on 1, the macro window
displays the 1 Macro that will be issued if
the specified variable is 1.

When you select a variable in the list box,
you specify the variable that determines
which macro is sent.

When you click on NEW, the Variable
Manager opens and you can create a
new variable.

When you click on 0, the macro window
displays the 0 Macro.

In normal mode, the macro window displays no options in the option bar. When you change to Press Time
Mode or Variable Mode, the option bar displays options as shown below.



UUssiinngg  tthhee  ““SSpprreeaaddsshheeeett””  MMaaccrroo  WWiinnddooww    

Other Home Theater Master remotes utilize a conventional macro list to program macros. However, the MX-3000
enables you to program macros with some types of macro steps occurring at exactly the same time as others.
Because of this, the macro window is in the style of a spread sheet.At the top of the window, the first step is listed,
then each row below represents the next group of steps.As you can see, in one row, only one step occurs, while in
other rows, many steps may happen simultaneously.

WWhhaatt  iiss  aann  AAlliiaass??    

An alias is a macro step that in one step refers to the entire macro programmed in another button. If only one com-
mand is programmed in the other button, then the macro step will only perform that command. However, if the
other button has a macro, the entire secondary macro will be played back as one step in the new macro.Thus, the
Alias feature not only saves memory (since it is not copying the IR commands, only pointing to them), but enables
you to program macros nested inside other macros. See advanced programming on page XX for some examples.

TTwwoo  WWaayyss  ttoo  RReeccoorrdd  AALLIIAASSEESS    

There are two ways to record macros.When you have many steps to record, the fastest method is to use the
Record button, then click on pages in an expanded tree view to display them, then click on the button you would like
to add as a step. Continue to navigate and click on buttons to record the macro.

When you just want to add one step to a macro you may prefer to use the Alias window. Select the button you
would like to add a step to, then simply double click in the column labeled Alias (click on the row you would like the
new step to be placed).

The Alias window allows you to browse all of the pages and devices in your configuration, but requires more mouse
clicks than normal macro recording most of the time. If your tree view is collapsed, then the Alias window is probably
a little faster to use, since you don’t have to press the Record button to add a step.
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In this example, the first step is to issue the Power On command to a TV.The next row has four steps occurring at the same
time; a delay of 2 seconds, a sound is playing, the text on the button is changing and a variable is being set to a new value (see
using variables to track power on page xx).After the 2 second delay, the TV’s input is changed. So six macro steps occured in 3
time intervals (represented by the rows numbered 1, 2, 3 etc.).

By simply double clicking on the “cell”
you want to add an ALIAS to, the Alias
window will be opened (without pressing
record first).



TThhee  AAlliiaass  WWiinnddooww    

RReeccoorrddiinngg  OOtthheerr  TTyyppeess  ooff  MMaaccrroo  SStteeppss    

For any other kind of step (other than Aliases), you do not have to click on record. Simply select the button you
want to add a step to, then either double click under the column you want to open the appropriate window (Text,
Variable, Sound, Delays, Jumps etc.) or click on the shortcut button in the macro toolbar.

RRee--AArrrraannggiinngg  tthhee  MMaaccrroo  SStteepp  OOrrddeerr    

You can drag any macro step to a new position by clicking and dragging.

DDeelleettiinngg  aannyy  MMaaccrroo  SStteepp    

You can delete any macro step by selecting it first, then hitting the Delete key on your keyboard.

TTiipp  --    YYoouu  ccaann  rreessiizzee  tthhee  MMaaccrroo  wwiinnddooww  bbyy  ssiimmppllyy  cclliicckkiinngg  aanndd  ddrraaggggiinngg  tthhee  ttoopp  ooff  tthhee  wwiinnddooww..    
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By simply double clicking on each dot,
you expand the tree, until you open the
page you want.When you double click on
the button ID of the button you want, the
Alias window will close and the new step
will appear in the macro window.



The RF Control Window

If the RF Control Window is closed, reopen it by clicking on the shortcut button on the toolbar or selecting RF
control from the Program Menu (Step 7).

OOvveerrvviieeww  ooff  BBaassiicc  RRFF  OOppttiioonnss    

Using the basic RF Control Window you can modify the RF properties of an MX-3000 as follows:

11 SSiiggnnaall from the Remote can be set to IR only, RF only or both IR and RF. The factory default is set to
both IR & RF.

NNOOTTEE!!  TThhiiss  mmuusstt  bbee  sseett  ffoorr  eeaacchh  ddeevviiccee  iinnddiivviidduuaallllyy!!    

22 RReecceeiivveerr  --  If you have multiple MRF-250’s in the system, you can select which receiver a device will be
connected to.The factory default is set to Default.

33 FFllaasshheerrss  -- You can choose which of the emitter ports a device is connected to.This is vital when your sys-
tem includes some identical components using the same IR code set. If you are installing a typical system
with an assortment of unique components using different IR codes, you can leave the Flashers set to the
factory default selection of ALL, however if operation is intermittent try routing to one flasher only.

OOvveerrvviieeww  ooff  RReecceeiivveerr  RRFF  OOppttiioonnss    

By clicking on the RECEIVERS button in the bottom left corner, you can extend the RF control window to display set-
tings for the MRF-250s in your system. In the extended window you have the following options:

11 AAdddd  BBuuttttoonn  --  If you have more than one MRF-250 base station, add and give each new receiver a unique
name in the window that appears.

22 RReennaammee  BBuuttttoonn  --  Before using the Rename button, you must click and select a receiver in the column
under Name, then click on the Rename button.

33 RReecceeiivveerr  IIDD  --  To prevent all receivers from receiving RF commands, you may opt to set a unique ID# to
each.This is only useful when identical components are installed in different locations. If your system has
an asssortment of unique components using different IR code sets, you may leave the receiver ID # set to
the factory default of ID 1.

44 IIRR BBllaasstteerr  --  Each receiver has a built in IR blaster, useful when you have more than six components to be con-
trolled. If you don’t have any use for this, turn it off, since it may issue too much IR for nearby components.
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WWiinnddoowwss,,  MMeennuuss,,  TToooollss  aanndd  DDeeffiinniittiioonnss

Set each device’s basic RF properties by clicking on the
row and column you want.When you do, a combo box will
display the choices available. Click on the option you want:



The Universal Browser Window
If the Universal Browser Window is closed, reopen it by clicking on the shortcut button on the toolbar.

OOvveerrvviieeww    

Using the Universal Browser Window you can import LEARNED IR codes from a .ccf file. You cannot import gener-
ated RC5, Database or generated NEC codes, only LEARNED codes.The browser works as follows:

11 Click on the File icon to navigate to the folder that contains the .ccf file.

22 Use Tree View to Navigate to the Panel
containing LEARNED IR codes you want.

33 Click on the panel name in Tree View to 
make the panel appear in Panel  View.

44 Click on a button in Panel View and
the Action List view will reveal whether
it has Learned Data or not. Only buttons
with Learned Data can be transferred.

55 Click and hold the left mouse button
to drag a button with learned data 
to any programmable button on the
MX-3000 in Simulate View Mode.

66 When you release the mouse, the blue
indicating a Learned IR command is

displayed on the simulate view of the
button.
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WWiinnddoowwss,,  MMeennuuss,,  TToooollss  aanndd  DDeeffiinniittiioonnss



Programming Overview

AA..    NNeeww  FFiillee,,  EExxiissttiinngg  FFiillee  oonn  PPCC  oorr  iinn  RReemmoottee    

NEW - Starting from scratch on a new job, go to the File Menu, choose New from the File Menu and pick
the type of template you would like to use to program with. None of the templates have any IR codes, just
prelabeled empty devices. It’s just personal preference whether you rename a list of devices or create new
ones in an empty configuration.

OPEN - Open a configuration that you have worked on before and saved onto the PC hard drive.

UPLOAD - Get a file from a client’s remote control that another installer created. Now, you can save the
file on your laptop, make any edits or changes as the client requests or the jobsite requires.

BB..    UUssee  SSAAVVEE  AASS      

The templates files are simply configuration files that have been preprogrammed for you. They will keep any changes
you make. Utilize SSaavvee  AAss to make a new file with a new file name. All configuration files are saved with the file
extension .rcc; all device files are also saved with the extension .rcc (see D. Save and Export, below).

TTIIPP  ——  Always use File | Save As to rename the file before doing any programming!  
Use the customer’s name and a rev # (i.e. SmithTheaterRev1.mxf)

CC..    UUssee  tthhee  PPrrooggrraamm  MMeennuu  

The Program Menu is your lifeline to a fast, easy programming experience. Follow the
steps in the order shown in the Menu for best results.Typically, you will download to
the remote control several times throughout this process and test what you have
done so far.You’ll need to download after finishing all programming. For macro play-
back to work, you need to have downloaded. These downloads are not listed in the
steps here in the Program Menu and are not automatically done for you.

It is important that you do all of the tasks for each step before moving on to the next
step. Keep this manual handy so that you can verify that you have completed all of
your tasks.

DD..    SSaavvee  aanndd  EExxppoorrtt  

Archive and save your customer files. In addition, you can export devices as .rcc files. Programming systems with simi-
lar components gets even faster when you don’t have to redo your work over and over. You have your own ideas
about what buttons should be labeled and how they should be arranged. You’ll save all of your work in a unique and
time saving way by exporting the device stand alone.That way, you can import just the device in any new configuration.

EE..    DDoowwnnllooaadd  ttoo  bbootthh  RReemmoottee  CCoonnttrroollss    

For once, you have a pre-printed summary sheet and an instruction manual for the entire Home Theater! Enjoy a
brief training with your client and get home on time tonight!

2222 PPrrooggrraammmmiinngg  OOvveerrvviieeww

U
S
I
N
G

M
X
3
0
0
0

E
D
I
T
O
R

T
O

P
R
O
G
R
A
M



Creating, Naming and Arranging Devices

A device is the basic grouping of a set of hard buttons and up to 255 soft button pages. You will need one device
group for each remote control that the MX-3000 is replacing. You can have a maximum of 255 devices in your
configuration.When you create devices in the Create and Name Devices window, every device is automatically linked
with a jump-link to the device via the MAIN MENU. If you create devices manually you have to create a jump link
from the MAIN menu button to each device manually, however you have better control over graphics.

OOppeenn  tthhee  CCrreeaattee  aanndd  NNaammee  DDeevviicceess  WWiinnddooww    

You can open the Create and Name Devices window by clicking on the first item of the Program Menu or by clicking
on the Toolbar icon as shown here.

TTIIPP  --    Hover the mouse over the Toolbar buttons and a pop-up label identifies it!  

CCrreeaattiinngg  DDeevviicceess    

11 Click on the grey button you would like to create a new device in or delete all the grey buttons and drag
in some icons from the Icon display:

22 You must NAME the device to create it in TREE VIEW, simply dragging the button does nothing but add a
button to the MAIN page.

33 You must hit the SAVE button to create all the new devices.

44 Once you have finished, you can simply click on Next Menu at the top of the window.

2233CCrreeaattiinngg,,  NNaammiinngg  aanndd  AArrrraannggiinngg  DDeevviicceess

M
X
3
0
0
0

T
O
U
C
H

S
C
R
E
E
N

R
E
M
O
T
E
S

You must NAME the device to create it. First
select the button that will represent the new
device (either drag it in or select an existing
button), then click in the NAME window and
type the new name for the device.

After you have named the device, click on
SAVE.



55 Tree View reveals the new devices you’ve created and the simulator shows the new MAIN page one with
all the new buttons displayed.

66 Try the simulate view mode out now. If you click once a MAIN MENU button, you’ll simply select the but-
ton, if you double click you will jump-link to the device group. Once at the new device group, you can
touch the MAIN button to return to the MAIN MENU, etc.

Creating, Naming and Arranging Devices Manually in Tree View

11 Select Devices in Tree View

22 Press the Insert key on your keyboard. Each time you press it, a new device is created.
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33 Select the first device and press the F2 key to name it.

44 Type in a new name and hit enter.

55 Repeat steps 3 and 4 untill all your devices are named.

66 Right Click on MAIN in tree view.

77 From the context menu choose Add New Page.

88 Double click on the new page in tree view to display it on either Simulate or Page view.

99 Open the Image Gallery by clicking on the shortcut button or select Image Gallery from the Tools
Menu.

99 Navigate to the MAIN MENUS by using the scroll bar and click on different MAIN MENUS until you see
the style you like.
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Use the scroll bar to navigate
to the various MAIN Menus in
the Image Gallery. 



1100 Pick one of the MAIN MENU ALL groups and click and drag the displayed group of buttons to the MAIN
page 1 display (either Simulate or Page View Mode, we are showing page view mode below).

1111 Arrange the buttons as you like, then select each of them in turn and uncheck the Display Text box if
needed.

1122 Programming a jump to the appropriate device in each of the buttons.

1133 When you are finished save your work by selecting Save from the File Menu or by using the keyboard
shortcut Control|S.
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You don’t have to drag a whole group from the gallery, you can choose to pick a background first,
then drag any icon or button over. It is personal preference.

When icons are dragged from the gallery,
the text labels need to be turned off by
unchecking the Display Text check box.



Create Button Layouts

Although you can manually create your own artwork in an image editing application for every button and arrange the
buttons in any way you want, it is not practical for most custom installation jobs.Thus, the MX-3000 Editor is
equipped with many choices for different clients in automatically configured button layouts.

OOppeenn  tthhee  CCrreeaattee  BBuuttttoonn  LLaayyoouuttss  WWiinnddooww    

You can open the Create Button Layouts window by clicking on the item #2 of the Program Menu or by clicking on
the Toolbar icon as shown here.

SSeelleeccttiinngg  BBuuttttoonn  LLaayyoouuttss    

11 Select the device you would like to create a layout for in the left hand column.

22 Now select the Template for the type of device it is.

33 In the Skin window, click on the different skins available and they will be displayed in the preview window.

44 Click on the Overwrite button to replace your existing pages. Click on Add to add to the existing pages.

55 Repeat for all of your devices.When you are finished click on close or Next Menu.
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Using the IR Database

DDiissccrreettee  CCooddeess,,  TToogggglleess  aanndd  ootthheerr  NNeeww  WWoorrddss    

The Home Theater Master database is unique in the industry because it includes “secret” discrete codes that are not
on the actual remote controls for many components. These codes are highly sought after by professional installers
because they make automation of the home theater possible via reliable macros! Here are the facts you need to
know:

DDiissccrreettee  CCoommmmaannddss  vveerrssuuss  TTooggggllee  CCoommmmaannddss
When a remote control’s only button to turn on and off a TV set is labeled Power, it is usually a “toggle” command.
Test it by pressing the button twice. If the power button turns on the TV, then turns it off, it is a toggle command.
That is a big problem when you are programming macros! If you program a macro for watching TV with a toggle,
then the macro is essentially point and pray (if the TV was off, it will turn on, if it was already on, it will turn off). On
the other hand, if a macro is programmed with a discrete Power ON command, the macro will work every time (if
the TV was off, it will turn on, if it was already on, it will stay on).

So the term “discrete command” or “discrete code” means that the code will only do ONE THING to a component.
For example:

A  single “Input” command is a toggle type command if it simply changes the input to another input when issued,
while separate buttons for Antenna A, Antenna B, Ext 1, Ext 2 and Ext 3 are discrete input commands if, when issued,
the TV goes directly to the named input (and if you give the same command again, it stays on the selected input).

Here are some important facts about Discrete commands:

““SSeeccrreett”” DDiissccrreettee  CCooddeess  eexxiisstt  ffoorr  ssoommee  ccoommppoonneennttss.. Why are they secret? Because the manufacturer
wants the remote control that accompanies the component to have the simplest appearance (fewest buttons). Since
toggles reduce the number of buttons, they make the remote control appear easier to operate. Many manufacturers
understand the needs of custom installers and build their components to also respond to discrete codes. They
distribute the discrete codes via service remotes, etc. For the first time, those codes are collected and integrated
into our database.

NNoott  aallll  ccoommppoonneennttss  rreessppoonndd  ttoo  tthhee  ddiissccrreettee  ccooddeess in the Database. A component has to be BUILT to
respond to discrete codes.The fact that other models from the same manufacturer do respond to discrete codes
is the reason the codes are added to a code set. However, some models will not respond, because the manufacturer
did not build it to respond through budgetary considerations, time constraints or a simple oversight.

SSeelleeccttiinngg  aa  CCooddee  SSeett  ffrroomm  tthhee  DDaattaabbaassee    

11 OOppeenn  tthhee  DDaattaabbaassee  WWiinnddooww  --  Select IR Database from the Program Menu or the Toolbar.

22 SSeelleecctt  tthhee  DDeevviiccee - Selecting the device you’d like to add codes to from the first list box.
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22 CCaatteeggoorryy  - Select the type or category of component (i.e.TV, VCR or DVD player).

33 BBrraanndd - Select the company that made the component (i.e. B & K, Sony, Krell)

44 MMooddeell - Select the Model or the Code Set number (sometimes the actual model, sometimes a generic #
assigned by us to a code set that operates many models over the years).

55 TTeesstt  aannyy  CCooddee  

A.Verify the MX-3000 is charged and connect it to the PC via the USB port.
B. Point the connected MX-3000 so that it is in range and within line of sight of the component.
C. Select the code you want to test from the function list.
D. Click on the TTeesstt button as shown above.

66 Once you find the correct code, you can Save All the codes with one click by clicking on the Save All but-
ton, or you can drag and drop any single code to any button.

77 Continue with the rest of the devices you need, using the Device list box).
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The device you
would like to add
codes to:

The category of
codes.

The brand of the
manufacturer.

The model number of the device.

NOTE: Many models are controlled
by generic code sets listed as Sony
1, Sony 2 etc. Beneath the listed
models, every brand will have a few
generic code sets. If you don’t see
your model number, try each of these
until you find the right one.



Testing 

In most home theater systems, you will find that some codes have to be learned. You may have a brand new
component whose codes are not yet in the Universal Database or you may have most of the codes for a
component, but a few are missing. To find out what you’ll need to learn, you must rigorously test all of the codes
you have programmed using the IR Database and correctly label the buttons that have to be learned. Of course
you can simply test a button and if it doesn’t work, go into learn mode, test the command, relearn as necessary
and so on. However, this wastes time. The best approach is to download, test all the commands, make a list, then
use MX-3000 Editor to modify labels, and delete unnecessary codes.

DDoowwnnllooaaddiinngg  ttoo  TTEESSTT  PPrree--PPrrooggrraammmmeedd  IIRR CCoommmmaannddss  FFrroomm  TThhee  DDaattaabbaassee    

When you choose Download from the File Menu or click on the Download button on the Toolbar, the Download
window appears unless you haven’t saved the file. If you haven’t saved the file yet, you will be prompted to do so.

PPrreeppaarriinngg  tthhee  LLiisstt  ooff  BBuuttttoonnss  ttoo  bbee  LLeeaarrnneedd    

1   Test  ALL Buttons  
Begin testing the codes you downloaded to the MX Remote Controls. Make sure that you test all
buttons (hard buttons and the LCD buttons on each page or every device). Don’t try to learn new
commands yet, wait until you can do all of them at once systematically.

2    Make a List of all buttons that don’t work.

3    Compare the original remote control to the button layouts you’ve created. Rename anybutton fro miss-
ing functions that need to be learned to the List. If you need to add pages, simply right click on the device
and choose Add Page. If you need more button layouts, open the Image Gallery.

HHiiddiinngg  PPaaggeess    

A hidden page is accessible during programming so you can teach commands to buttons on hidden pages and use
them in macros.The interesting thing about hidden pages is that the end user cannot manually access the page
using the PAGE button. You HIDE pages using the HIDE checkbox which appears in the Page Menu or by right
clicking on a page in tree view.

TTiipp  --  YYoouu  ccaann  ssttiillll  pprrooggrraamm  aa  MMaaccrroo  ttoo  jjuummpp  ttoo  aa  HHIIDDDDEENN ppaaggee  ffoorr  ssppeecciiaall  ppuurrppoosseess!!    
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Learning Tips

FFrreesshh  BBaatttteerriieess  iinn  tthhee  OOrriiggiinnaall  RReemmoottee  CCoonnttrrooll  -- Weak batteries will cause MX-3000 Editor to fail to
correctly learn. Note that EVEN if the original remote still operates the component, the batteries can be
too weak to produce a strong enough carrier for any learning remote control to detect!!!! When a code fails,
replace the batteries FIRST!

TTaapp  iinnsstteeaadd  ooff  PPrreessssiinngg  aanndd  HHoollddiinngg  -- With some codes, this will produce better results. Normally, you should
press and hold.

TThhee  ““FFlluutttteerr””  TTeecchhnniiqquuee  -- If you are having problems with a Code that has to be sustained (like volume up
or down), sometimes fluttering the button while in learn mode will reduce errors.

TThhee  ““SSeemmaapphhoorree””  TTeecchhnniiqquuee  -- Use a book or another opaque object in between the two remotes. Press the
button on the original remote, then remove the obstruction for a moment, then put it back. Experiment with
different timings.

Learning IR Codes One at a Time

11 SSeelleecctt  tthhee BBuuttttoonn  -- Select the button that you want to teach to by single clicking it.

22 CClliicckk  oonn  tthhee  LLEEAARRNN  SShhoorrttccuutt BBuuttttoonn    oorr  cchhoooossee  LLeeaarrnn  ffrroomm  tthhee PPrrooggrraamm  MMeennuu-- The Learn IR window
opens.

33 CClliicckk  oonn  tthhee  LLEEAARRNN  bbuuttttoonn  aatt  tthhee  bboottttoomm  ooff  tthhee  LLeeaarrnn  IIRR wwiinnddooww  ttoo  ooppeenn  tthhee  LLEEAARRNNIINNGG wwiinnddooww..
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Start with the remote controls an inch apart. The origi-
nal remote points at the back of the MX-3000.Vary the
learning distance from one inch to as much as four feet
if the code doesn’t test correctly.



33 The Learn Window opens,Wait for READY to Appear -- The MX-3000 must be connected to the PC. Once
you see the 1rst Learning READY indicator, press and hold the corresponding button on the original
remote control while pointing it at the BOTTOM of the MX-3000.

44 When the code is successfully learned, the window will say GOOD, confirming that the code learned “cor-
rectly.”  Actually, the GOOD means that the code might be good....You need to test it. Select the code in
the Current Learned IR List, then click on the test button.

55 If the code doesn’t operate the component you can try the DoubleTap learning method.This is particularly
useful for components using the Philips RC5 ‘togglebit” protocol. Many high end audio companies use
these codes. Just click on the 2-Learn radio button and you will be prompted to learn every code twice.

66 CClliicckk  oonn  SSAAVVEE  -- You must click on SAVE to save the LEARNED command.
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Learning a Batch of Buttons Efficiently

TTiipp  --    FFiinndd  tthhee  ccoorrrreecctt  ““lleeaarrnniinngg  ddiissttaannccee””  uussiinngg  ssiinnggllee  ccooddee  lleeaarrnniinngg  bbeeffoorree  
bbeeggiinnnniinngg  bbaattcchh  lleeaarrnniinngg..

11 Select the STARTING Button - Select the button that is the top left of the buttons you want to teach to.
When learning a batch of hard buttons, MX-3000 Editor starts at the VOL up, moves down the hard but-
tons on the left, then goes to the top right hard button.When learning soft buttons, MXEditor starts at the
top left, moves across each row, then moves down.

22 SSeelleecctt  NNEEXXTT BBUUTTTTOONN  bbuuttttoonn  bbeeffoorree  yyoouu  pprreessss  LLEEAARRNN  -- The combination activates the batch learning
capability of MXEditor.

33 WWaattcchh  tthhee  LLEEAARRNNIINNGG WWiinnddooww  -- When the info window says READY, press and hold the button on the
original remote control.When it says GOOD, release the button. During batch learning, MXEditor auto-
matically saves and then reselects the next button. When you see that a new button has been selected
and the LEARNING window says READY, then teach the corresponding button on the original remote
control. This greatly speeds the learning process.

TTiipp  --  TToo  sskkiipp  aa  bbuuttttoonn  iinn  tthhee  aauuttoommaattiicc  sseeqquueennccee,,  ssiimmppllyy  cclliicckk  oonn  tthhee  SSKKIIPP bbuuttttoonn..  

44 You can opt to test any code by selecting it in the Currently Learned IR list. If it doesn’t work, delete it
before saving or relearning.

55 Save the Codes you’ve batch learned by pressing the SAVE button.All the codes are transferred to the top
Embedded IR list.The buttons you taught commands to now show the blue L icon in Simulate View mode.

All the codes
you learn appear
in the Current
Learned IR list.



Advanced IR Code Manipulation

MMooddiiffyyiinngg  CCaarrrriieerr  FFrreeqquueennccyy  iinn  aa  LLeeaarrnneedd  CCoommmmaanndd    

11 Open the LEARN window and select the command that is buggy in the Embedded IR List.Adjust the carri-
er frequency to the correct frequency here.

Note:Typically the reason that the carrier was not detected correctly was because of low batteries in
the original remote control at the time of learning.

CCrreeaattiinngg  aa  BBuuttttoonn  tthhaatt  SSuussttaaiinnss  tthhee  IIRR CCooddee  ffoorr  SSeevveerraall  SSeeccoonnddss  ((PPrree--PPrrooggrraammmmeedd  oorr  LLeeaarrnneedd  CCooddeess))    

11 Select the button with the code you would like to adjust. Many projectors require a two to four second
burst to power on or off.

22 In the Macro window, double click on the command (learned or pre-programmed) to open the IR Data
window.

3344 AAddvvaanncceedd  IIRR  CCooddee  MMaanniippuullaattiioonn
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Adjust the number of repeats and test
the code. With some brands, a two
second burst might be 18 repeats, with
another two seconds might be 50
repeats. You have to use trial and error
to find out how many repeats you
need.

If you no longer want the button to
repeat while it is pressed and held,
uncheck the Repeat checkbox.

If you would like to access another IR
command, click on the Expand button.
You can then select a command from
any database or learned code.



Importing and Exporting Devices

Save your work so that it can be easily used on other jobs with the same compoenents.You can just save files by cus-
tomer name, but a better approach is to export devices one at a time.That way you can import just the device you
want in another job, complete with all your artwork, button layouts, labeling, and macro programming.

TTiipp  --  NNaammee  yyoouurr  EEXXPPOORRTTEEDD  ddeevviiccee  ffiilleess  bbyy  CCaatteeggoorryy,,  MMaannuuffaaccttuurreerr  &&  tthhee  MMooddeell  ##..    

EExxppoorrttiinngg  SStteepp  bbyy  SStteepp    

11 From the File Menu choose Export.

22 When the Export window opens, check off the device you want to export.

33 Click on the Browse button to open a browser window. Select the file destination and name the file
according to the Category, Manufacturer and Model.

44 Click on the SAVE button in the Browser window.You now return to the Export window.You have not
saved the file until you press the OK button.

3355TTyyppee  iinn  SSeeccttiioonn  TTiittllee
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IImmppoorrttiinngg  SStteepp  bbyy  SStteepp    

11 From the File Menu choose Import.The Import window appears.

22 CClliicckk  oonn  tthhee  BBrroowwssee  bbuuttttoonn  ((......))  ttoo  ooppeenn  aa  bbrroowwsseerr  wwiinnddooww.. Navigate to the folder you keep your devices
and select it.

33 Click on the Open button and you are returned to the Import window.

44 From the list of devices, select the one you want by checking the check box, then clicking on Apply.The
new device appears in Tree View.You can repeat as many times as you like.

3366 TTyyppee  iinn  SSeeccttiioonn  TTiittllee
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Macro Programming

WWhhaatt  iiss  aa  MMaaccrroo??    

A macro is a recording of a sequence of commands that is played back when the user presses a single button. A
macro can have up to 255 steps. A step can be:

AALLIIAASS-- Any IR command or Macro on any button on any device.

DDeellaayy  -- Adjustable delay between steps of .1 and 99.9 seconds. Longer delays can be created by using
more than one delay. If a delay is programmed as the first step in a Macro, the macro will not be issued
until the button is pressed and held for the specified amount of time.

JJuummpp  -- As the last step in a Macro, you can specify a jump to any page of any device. You can program
another jump in the macro to display a page with status feedback messages or animations.

SSoouunndd  -- Any step can have a sound WAV file programmed. However, to program a second sound file in the
same macro (so that there is a beep at the beginning and a “tada” at the end of a macro), you must pro-
gram a delay in between the two sounds as long as the first sound or longer.

TTeexxtt  -- Any step can make the button label change. If you want the label to stay changed, insert a delay
after the text step to keep the text on for enough time for your client to read it.

SSEETT  VVAARRIIAABBLLEE Opens the Set Variable window, which enables you to pick an already-created variable and set
it to 0, 1 or to simply Invert its status as a macro step. If you want to create a variable, you
must click on NEW at the top of the Edit & Label Buttons window to open the new variable
window.

IIRR  DDAATTAA  Opens the IR Data window, which allows you to insert an IR command as a macro step without
aliasing to it.This is slower than programming an alias, but has the advantage that you can control
the IR commands burst length inside the macro, enabling sustained bursts of power on for projec-
tors, or long busts of volume down at the end of a turn on macro. See Using the IR Data Window
on page XX.

IIMMPPOORRTT  You must select the button you want the macro imported to, click on the Import button, then
click on the button containing the macro you want copied. All of the macro steps are inserted
into the new button in one step. Make any changes you want to the new macro, it is independent of
the original (the original is not affected by any changes you make, nor is the copy affected by
changes you make in the original).

SSLLEEEEPP  TTIIMMEERR  Insert this as the first step of a power off macro. Label the button SLEEP TIMER. Each time the
user presses the button, the MX-3000 displays “Go to Sleep in 90 Minutes”, the next press it
displays “Go to Sleep in 60 Minutes”, next it displays “Go to Sleep in 30 Minutes”, then “Go to
Sleep in 15 Minutes” and finally “Cancel”.Whenever the Sleep Timer runs out, the macro you
programmed will be issued (unless the user hits the cancel display).

AAllll  BBuuttttoonnss  CCaann  PPllaayybbaacckk  MMaaccrrooss  eexxcceepptt  tthhee  MMAAIINN  aanndd  PPAAGGEE BBuuttttoonnss..  
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DDiissccrreettee  IIRR CCooddeess  vvss  TTooggggllee  IIRR  CCooddeess      

Manufacturers program their products to respond to IR codes with one action or many:

TTooggggllee  --    More than one action can occur when the code is sent by a remote control. An example is a POWER but-
ton.The manufacturer programs the TV to respond to a POWER command by turning it on if it was off and
turning off if it was on. So one button can do two things. This requires that the user “know” or “see” that the
television is on or off before pressing the button.

Another example is a television with an “INPUT” command. When the code is issued, the television changes its
input. Since the television has 5 inputs, the single “INPUT” command can have five different results, depending on
what input was previously selected.The user has to “know” or “see” what input was previously selected before
deciding how many times to push the INPUT button.

DDiissccrreettee  -- Only one action can occur when the code is sent by a remote control. An example is a television with
a POWER ON button and a POWER OFF button. If the television is already on, the POWER ON command has no
effect. If the television is off, the POWER ON command will turn on the television. Another example is a television
with five discrete input commands (ANT A, ANT B, EXT 1, EXT 2 and EXT 3). No matter what input was previously
selected, any of these commands will change the television to the desired input WITHOUT the end user “knowing”
or “seeing” what the previously selected input was!

TTiipp  --  NNoott  aallll  ccoommppoonneennttss  hhaavvee  ““ddiissccrreettee””  ccooddeess  oonn  tthheeiirr  oorriiggiinnaall  rreemmootteess,,  cchheecckk  tthhee  IIRR  DDaattaabbaassee!!..

TTooggggllee  CCoommmmaannddss  ccrreeaattee  ““PPooiinntt  &&  PPrraayy””  MMaaccrrooss      

Imagine a system with three components (a TV, a VCR and a surround sound Receiver). Each has a toggle type
POWER command on the original remote control. You program a macro with the three power commands on the
MAIN Power ON button and tell your client to turn on their system with this button. Here’s what will happen:

The client will pick out a videotape and insert it in the VCR (the VCR will now automatically turn on).The client sits
down, picks up their MX remote control and presses the MAIN Power On button.The three toggle type power com-
mands are issued. So, since the TV and the Receiver were Off, they turn on, however the VCR was already on from
inserting the tape, so it turns off. The client is puzzled that they don’t see a picture, so they press the MAIN Power
On button again.The three toggle type power commands are issued again.This time the TV and the Receiver turn off
and the VCR turns on.The client begins to get frustrated...

TTIIPP  --    FFoorr  ssyysstteemmss  wwiitthh  lloottss  ooff  ttooggggllee  PPoowweerr  ccooddeess,,  ccrreeaattee  aa  ““PPoowweerr”” hheellpp  lliisstt..    
You cannot successfully train a family to use a Point & Pray macro. It is too inconsistent. You are
better off creating a help list device named “POWER.” On the Power Page 1, create shortcut
buttons to all of the components toggle power commands.Train the customer to turn on the system
by pressing the Power button on MAIN, then turning anything that they need on one at a time. Once
the system is on, they press MAIN and decide what they want to watch or listen to.

PPrrooffeessssiioonnaall  IInnssttaallllaattiioonnss  RReeqquuiirree  ““BBuulllleett--PPrrooooff””  ((RReelliiaabbllee))  MMaaccrrooss  oorr  aa  hheellpp  lliisstt..  TThhee  uussee  ooff  PPooiinntt  &&  PPrraayy  mmaaccrrooss  wwiillll
ccrreeaattee  sseerrvviiccee  ccaallllss  aanndd  aa  lloott  ooff  bbaadd  wwiillll..  NNeevveerr  lleeaavvee  aa  ccuussttoommeerr  wwiitthh  aa  rreemmoottee  pprrooggrraammmmeedd  ttoo  ““mmaayybbee””  wwoorrkk......
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FFiinnddiinngg  WWoorrkkaarroouunnddss  ffoorr  TTooggggllee  CCoommmmaannddss  iinn  MMaaccrrooss    

By creatively experimenting you may find that you can workaround the lack of discrete codes.This takes time and
there is no guarantee that you will find a workaround for any given component. Here are some common examples:

DDVVDD  aanndd    VVCCRR  PPoowweerr  WWoorrkkaarroouunndd
Most DVD players will turn on when off when they receive a Play command.Thus you can workaround like this:

DVD ON = 1) Play 
2) DVD Stop

TTVV  ssccrroolllliinngg  ““IINNPPUUTT””  WWoorrkkaarroouunnddss
Many televisions respond to a channel up or a channel number command by changing to the Antenna input regardless
of what input was last selected.This creates an “anchor” action that puts the television in a known input.Thus you
can create a workaround as follows:

EXAMPLE - CH Up takes TV to the ANT A input (and the TV has 5 inputs -Ant A, Ant B, EXT1, EXT2 and EXT3)

TV to EXT3 = 1) Ch Up (takes TV to ANT A regardless of what input was last selected)
2) Input (takes TV to next input - ANT B)
3) Input (takes TV to next input - EXT 1)
4) Input (takes TV to next input - EXT 2)
5) Input (takes TV to desired input - EXT 3)

EXAMPLE 2 - Any channel number and ENTER takes TV to the ANT A input (and the TV has 5 inputs -Ant A, Ant B, EXT1,
EXT2 and EXT3)

TV to EXT3 = 1) “0”
2) “2”
3) “Enter” (takes TV to ANT A)
2) Input (takes TV to next input - ANT B)
3) Input (takes TV to next input - EXT 1)
4) Input (takes TV to next input - EXT 2)
5) Input (takes TV to desired input - EXT 3)

PPrrooggrraammmmiinngg    aa  PPoowweerr  OOnn  MMaaccrroo    

Set up your laptop and the connected remote within operational range of the home theater system while
programming the Power On macro. Power On macros usually require extensive testing of delays and you can
expect to do a lot of experimenting while programming.

11 Select the System Power On button on the MAIN page.

22 Click on the RECORD icon 

33 Take a look at the MAIN page (both pages if you have two MAIN pages). Decide which components you
want to power on. Start adding their Power On commands to the list by navigating to the device and page
where the codes are located and clicking on the buttons with the Power On commands. Select the device
by clicking its button on the MAIN menu or by clicking on an expanded tree view page.
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44 Now, click on the button with the device’s Power On command.

The new step appears in the Macro spread sheet:

44 Once you have all of your Power On commands in the list, re-arrange them as desired by clicking and
dragging them into whatever order you want.

55 Ask the client what they think they will watch most often (TV, satellite, DVD, etc.). Program steps to select
the correct TV and Receiver input for that activity. In this example, both the television and the receiver
have discrete input codes and the client’s favored activity is watching Satellite.

Select the RCVR by clicking its button on the MAIN menu. Now, click on the button with the SAT input
command.The new step appears in the list.

66 Select the TV by clicking its button on the MAIN menu. Now, click on the button with the correct input
command.The new step appears in the list. Press the Stop button to stop recording ALIASES.

77 OPTIONAL - Program a jump to the Device and Page they use for their favorite activity.
Click on the JUMP icon. Select the correct device and page from the Jump window.The jump appears in
the Macro window in the column under Jump.

88 First, turn the TV and the Receiver to the wrong input, then turn off everything in the theater. Point the
connected MX-3000 at the system. Select the first step in the list by clicking on it. Now, click on the TEST

button. Observe the television and the receiver. Did they both switch to the correct input?

99 Programming additional delay in the macro is sometimes necessary. Each macro step usually takes some
time, so there may be enough built in delay for the television and the receiver to both be fully active by
the time the input commands are sent. Sometimes the component is not fully awake. It is fashionable for
many modern televisions and receivers to require 5 or more seconds of warm up time before they are
responsive to new commands. In a case like that, you will need to add more delay between steps.

4400 TTyyppee  iinn  SSeeccttiioonn  TTiittllee
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1100 Select the Delay icon 

Now, click on the preset amount of delay or enter any time between .1 second and 30 seconds in the
“Customize” window.

1111 The new step appears in the list. Now, drag the delay step to the correct location.

TTIIPP --  SSoommeettiimmeess  aa  cchhaannggee  iinn  oorrddeerr  ccaann  pprroovviiddee  tthhee  ddeellaayy  yyoouu  nneeeedd..  

1122 Again, turn the TV and the Receiver to the wrong input, then turn off everything in the theater. Point the
connected MX-700/800 at the system. Select the first step in the list by clicking on it. Now, click on the
TEST  button. Observe the television and the receiver. Did they both switch to the correct input?
Continue to revise the macro with delays or changes in order and test until the macro ALWAYS correctly
turns everything on and switches the surround sound receiver and television to the correct input.
When the macro is perfect, click on the SAVE in the File Menu.
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PPrrooggrraammmmiinngg  aa  PPoowweerr  OOffff  MMaaccrroo    

A Power Off macro is much simpler than a Power On macro, since there are rarely any delays to test, etc. Usually, to
give the client some feedback that the macro is working, the TV is turned off first.

When you are forced to “workaround” a DVD player or  VCR without a discrete off command, you will make the
macro more reliable if you place the time consuming anchor (the play command) at the beginning of the macro.
Make sure that you turn the DVD player off before testing this kind of workaround. You are testing the worst case,
you know that a toggle type power command will turn the DVD player off, you are concerned about an event that
might happen.The DVD player is already off, but the client presses the MAIN Power Off to turn everything else on. If
you only programmed a toggle Power command, everything else would turn off, but the DVD player would turn on.
This “workaround” ensures that the DVD player turns off.

PPrrooggrraammmmiinngg  AAccttiivviittyy  MMaaccrrooss  oonn  MMAAIINN  LLCCDD ““DDeevviiccee”” BBuuttttoonnss    

An Activity Macro is typically programmed to be as fast as possible. They simply select the correct input on both the
television and the surround sound receiver, since all the components have already been powered on by the Power
On macro.

There is no need to program a JUMP to a page in a MAIN “Device” button created by Create and Name
Devices.They are automatically programmed to JUMP to the Device.

Sometimes activity macros will share the same input settings. Here, a DVD player doubles as a CD player. The
programmer has copied the DVD device, named it CD, so that there are two identical devices (with the same DVD
player IR codes).The only difference between them is the Activity Macros you see below. The DVD Activity Macro
selects THX Surround Sound with 5 speakers with the TV on, while the CD Activity selects Stereo with 4 speakers
and forces the TV off. For components that have play commands it is typically ok to have a “Play” command in the
macro.Watch out for components with toggle type play/pause buttons.That kind of “Play/Pause” command should
not be placed in an Activity Macro without a preceding “Stop” command, to make sure that the toggle can only play
the component!

OOnnee  DDVVDD  PPllaayyeerr  --  TTwwoo  DDeevviicceess  aanndd  TTwwoo  AAccttiivviittyy  MMaaccrrooss

DVD Activity Macro CD Activity Macro

Note how the programmer is using the same DVD input on the surround sound receiver for both activities, the
macro simply changes the surround sound settings.

TTIIPP  --  DDoonn’’tt  OOVVEERRAAUUTTOOMMAATTEE,,  mmaakkee  ssuurree  tthhaatt  eevveerryy  sstteepp  iiss  ttrruullyy  uusseeffuull!!    
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IImmppoorrttiinngg  MMaaccrrooss  ((CCooppyyiinngg  oorr  CClloonniinngg  aa  MMaaccrroo))    

You can often speed programming by instantly inserting all of the steps of a previously programmed macro as the
starting point of a new macro.The inserted steps are completely editable, without changing the original macro.

11 Do not start recording at the new location. Simply select the button where you would like the macro
inserted.Then click on the IMPORT button.

22 Navigate to the device and page where the original macro is programmed. Click on the button that
contains the macro. During navigation, you might click on a device button which happens to contain a
macro. A popup window will appear asking if you want to insert this macro. Answer NO if you are simply
using the device button to navigate. Answer YES if you want this macro copied/cloned/inserted.

33 When you click on the button that contains the original macro, all of the steps are copied/cloned into the
new button location and the Simulate view jumps back to the new button’s device and page.

44 Edit as needed and click on SAVE.
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Programming Punch Through

MX-3000 Editor enables you to quickly set up common functions on all devices for the hard buttons. Usually used
only for Volume Up, Down and Mute; however, you may find it convenient to punch through to the satellite Menu
controls and the Channel UP and Down.

11 Open the Punch Through window by clicking on the shortcut button in the toolbar or by selecting
Punch Through from the Program Menu.

22 Select the devices which you want to change programming by clicking on them
while holding down the CONTROL key on the keyboard. If you want them all
selected (normal for Volume Up, Down and Mute), simply click on the Select All
button. Any device you select will be HIGHLIGHTED in the “Punch To” list.

33 Select the device that has the codes you want used in the Punch From list.

44 Click on SAVE. Check the devices you programmed, you should see the red PT (Punch Through) flag on
every button affected on all the devices you programmed:

TV VCR1 MAIN

55 Repeat for any other groups of codes as you like.
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Programming RF Control Options

TThhee  RRFF SSeettuupp  WWiinnddooww    
The RF Setup window opens after selecting RFControl from the Program Menu or
clicking on the shortcut button.

AAddjjuussttiinngg  SSiiggnnaall  aanndd  IIRR OOuuttppuutt  OOppttiioonnss    

The RF Setup window enables you to adjust the properties of RF Control by clicking on the intersection of a row and a column
and then selecting from the pull down list box the property you want.All of your devices are displayed. You can set each device
individually to be controlled by clicking on the cell you want to change.After clicking, a list box of options will appear.

SSIIGGNNAALL controls how the MX-3000 will send commands:
IR and RF - Both RF signals and IR commands

are sent from the MX3000. The RF
signals will also be issued as IR com-
mands by the MRF-250.

IR  - Only IR commands are sent from
the MX3000, as a result the MRF-
250 does not send any commands.

RF - Only RF signals are sent from the
MX3000, as a result only IR com-
mands from the MRF-250 are
received by the device.

RREECCEEIIVVEERR enables you to select which MRF-250
receiver will receive the commands for this
device.Thus, you can send commands to a device
in another location via a second MRF-250 placed
in that location (up to 16 in one house).

Note: In a system with only one MRF-250 receiv-
er, this does not need to be adjusted.
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IIRR OOUUTTPPUUTT controls the Line Outputs for Flashers
affixed to the front panels of components.You
can opt to either send IR Commands to:

ALL - The commands are sent to all of
the Flashers

1-6 - Just the specified Flasher receives
the IR commands (Useful when
identical TV’s or VCR’s are utilized
in the system)

AAddddiinngg  MMRRFF--225500  RReecceeiivveerrss,,  CCoonngguurriinngg  IIDD##’’ss  aanndd  FFrroonntt  BBllaasstteerrss    

To add a new receiver to the list, to change the Receiver ID# of your existing receiver or to enable/disable the Front Blaster,
click on the Receiver button of the RF Control window.
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You may rename a receiver to something
more descriptive by first selecting the
receiver’s name cell, then clicking on the
Rename button.

If you want the Front Blaster turned OFF on
any receiver, reset it by clicking on the correct
CELL and selecting OFF.

NOTE: In some installations, the MRF-250’s
Front Blaster is so powerful that it can overload
nearby components and give poor or intermit-
tent operation. Try re-positioning the MRF-200
to reduce the power flooding the cabinet or turn
the Front Blaster off.

After pressing the Receivers button, the RF
Control Window will enlarge revealing the
Receiver configuration options.Again, you click
on a cell to adjust.

The Receiver ID cells enable you to change the
ID# of each receiver, so that commands for one
will be ignored by the other if set to different
ID’s.

Note that in this system, the MRF-250 in the eq
uipment closet is set to ID#2 and the MRF-250 con-
nected to the identical TV’s is set to ID#1.



Setting Up the MX-3000 Defaults

11 Open theRemote Control System Setup
window by clicking on the shortcut 
button on the toolbar or selecting it 
from the Communications Menu.

22 Enter the amount of time you would like
the backlighting to stay on (after a button
is pushed) for both settings, on battery 
power and on the cradle.

33 Adjust the brightness and the sound 
volume to your taste.

44 Set the backlighting of the hard buttons 
in the Button Light section.

55 Set when the MX-3000 should give a 
low battery warning.

66 Set the pickup sensor on or off.

77 Save the settings or download them 
to test.

Setting Up the MX-3000 User Preferences

11 Open the Preferences window by clicking on
Preference in the File menu.

22 If you would like to change the default font
for your buttons, select it here.

33 If you would like to speed up macros, lower
the Default Macro Repeat. Most components
need only 1 burst. However some brands 
(most noteably JVC) require 3 bursts. By 
lowering the default # of repeats, you speed
up your macros dramatically.

44 If you have created your own gallery, skin or
template, you can set it as the default here.

55 Set your default beeps for all buttons.

66 If you wish to write protect the system, so 
that no other installer can edit your file,
enter passwords to both fields.

77 Click on OK to save your settings.
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Downloading to MX-3000

You download to the remote control by:

11 Make sure the remote control has charged batteries.

22 Connect the cable between the PC and the remote control.

33 Verify that the file you have open in MX-3000 Editor is the one you want to download to the remote con-
trol.

44 Click on the Download to Remote Control shortcut button on the toolbar or choose Download from the
Communications Menu. Do not move the mouse or touch the keyboard during the download.

TTIIPP --  MMaakkee  ssuurree  tthhaatt  tthhee  ccaabbllee  pplluugg  iiss  ssoolliiddllyy  ppuusshheedd  aallll  tthhee  wwaayy  iinn  ttoo  tthhee  ccoonnnneeccttoorr..        

Uploading from the Remote to PC

Uploading is necessary when you arrive at a jobsite with an existing MX-3000 system that you would like to service,
edit or clone. Simply upload the file to your PC, save it with a new file name and you can edit the file, send it to
other remotes, make a touch up and download back into the customer’s remote.

11 Make sure the remote control has charged batteries.

22 Connect the cable between the PC and the remote control.

33 Save any work and open a NEW empty file.

44 Click on the Upload from Remote Control shortcut button on the toolbar or choose Upload from the
Communications Menu.

55 When the upload is complete, save the file with a new file name.
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Using MX-3000 Tools

MX-3000 Editor incorporates some useful tools for custom installers who like to organize their work, so that each
new job gets easier than the last.You can create your own custom image or sound galleries and easily switch
between them. You can make a record timer of any macro. Just head up to the Tools Menu and experiment.

UUssiinngg  MMaakkee  MMyy  IIRR DDaattaabbaassee      

The IR database used for the Editor is huge and contains thousands of brands and models. Sometimes the size of the
database can slow you down as you scroll past all the brands you don’t ever install.You can easily create your own
database of just the brands and models you like by choosing Make My IR Database from the tools menu.

11 Select the code sets you need on the left.

22 Click on the right facing arrow to transfer a
code set to your IR database.

33 Continue to work through the database and
transfer any code set to your database.

44 After you have finished, click on OK.

55 To use your IR database during programming
simply open the normal Database window from
the Program Menu then choose Use My Database
on the top radio buttons.

Note that the IR Database window also enables you to search the Embedded Learned IR codes and drag them to any
button as easily as you drag an IR database command.

UUssiinngg  TThhee  EEmmuullaattoorr    

Instead of downloading to the remote, you can
check your work with the Emulator. Simply choose
Run Emulator from the Tools Menu and your
current configuration will be loaded and displayed
in a real working PC screen mockup.You can test
all of your navigation and check for any problems
without downloading to the remote control.

To close the emulator, right click on the emulator 
and choose Exit.

If you would like to test the IR codes, right click and 
choose IR Test.

If you would like to watch macros, right click and choose show action list.
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Push and Hold Macros

Any macro can be programmed so that nothing will happen if the button is simply tapped. You can force the client to
press and hold for any time between .1 and 99 seconds to issue a macro. For most clients, this would be a bad idea
since it makes things more difficult and more time consuming. However, here is an application that we think you
might find useful for particular clients:

PPuusshh  aanndd  HHoolldd  ffoorr  AAccttiivviittyy  MMaaccrrooss  aanndd  TTaapp  ttoo  SSwwiittcchh  DDeevviicceess    

If you have a hobbyist client, a power user who is constantly switching devices and making adjustments to different
components, this can improve operation for him/her.

Here’s how this application works:

Program all of the MAIN MENU Activity Macros with the Macro Window in PRESS Mode and the option
bar set to AFTER .This ensures that the client will have to Press and Hold the button to issue the Macro.

With the option bar set to BEFORE, program a jump to the device only.

When the client simply taps a MAIN activity button, he/she simply switches devices.

OOnnee  BBuuttttoonn  IIssssuueess  TTwwoo  DDiiffffeerreenntt  MMaaccrrooss      

Since you can program 255 steps in either the BEFORE or the AFTER macro, you really have complete freedom to
program anything you can think of.

Status Messages for Impatient Clients with Long Macros  

For clients who have problems waiting for long macros to finish, it is helpful to design the system to give a dramatic
status message while the macro is working, otherwise they may put the remote down in the middle of the macro, frus-
trating themselves. All you need to do is create some extra pages and place big buttons with text or graphics or even
animated graphics on each page. Insert jumps to the appropriate pages in your macro and the result is that the client
sees a slide show with your messages on it as the macro plays back.You can do a smaller version, by programming text
in the macro itself, text shows up only on the button, so may not be visible enough for clients

Helping Confused Clients

When do clients get confused? When their system is full of old gear they couldn’t afford to replace! When the
salesmen sell components without discrete codes! When the manufacturer of a cool new product blows it and
incorporates hard to use, but vital features! 

In any event, by using MXEditor you can often solve some problems very effectively.

TTOOAADD  --  TTVV  IInnppuutt  ““SSccrroollllss””  oorr  ““TTooggggllee””  aanndd  hhaass  nnoo  WWoorrkkaarroouunndd    

When you have a component that is difficult to automate, it helps to call it names (TOAD, for Toggle Only Actuated
Device, has been suggested). Once you have vented your feelings, get out MX3000 Editor and go to work.There is a
relatively simple way to make operation of a device like this much less confusing. Here’s how to go about it:
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UUssiinngg  VVaarriiaabblleess  ffoorr  TTooggggllee  OOnnllyy  AAccttuuaatteedd  DDeevviicceess    

The key to using this technique is reliable RF communication between the MX-3000 and the MRF-250 base station. If
the MRF-250 is placed carefully, and is getting no RF interference, the variable technique is very reliable.
Fundamentally, you are going to program the MX-3000 to remember that the component is on or off, and only issue
the toggle type Power command when needed.The system can get out of sync if the client turns on the TV with
another remote control or by hand.

11  Create a new device and name it Power Tracking.Add a page to it.

22 Drag a button from the image gallery onto the page. Label the button for the component.We’ll call our
example TVPowerOn.
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33  With the TVPowerOn button SELECTED, click on the VARIABLE MODE button.

44  The Variable Option bar appears.

55  Click on the NEW button in the Variable Option bar.

66  The Variable Manager window opens up.

77  Type in TVpower and click on Apply, then Close the Variable Manager.

88  Click on Option 0 in the Option bar. Select the variable TVPower from the list box.

99  Program the toggle TV Power command as the only step in the 0 macro.

1100  Double click the Set Variable button on the macro toolbar or double click on a cell in the VAR column.The
Variable window will open.

1111  Select the TVPower variable from the list and click on the 1 radio button (in the macro, you just issued the
power command and turned on the tv, so you are setting the variable to 1 (tv is on). Then click OK.
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1122  Click on Option 1 in the Option bar. Select the variable TVPower from the list box. Don’t program any IR
commands in the Option 1 macro. It should do nothing.

1133  Save your work, choose Save from the File menu. Now it is time to create a second button, called
TVPowerOFF, repeat steps 8-12 but program the TVs toggle power off command in Option 1, then set the
TVPower variable to 0.With this button, you program nothing in Option 2. Save your work.You have just
programmed two discrete commands from a toggle! To implement, simply alias to the TVPowerOn button
in any macro where you want to check that the TV is on, and alias to the TVPOwerOff button when you
want to check that the TV is powered off.The client must be trained to never use any other remote con-
trol or to turn on the TVby hand.
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